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Questionnaire:
A.  Will you require JoVE to record video microscopy, such as filming a complex dissection or microinjection technique? No
B.   Does your protocol include detailed, step-by-step, descriptions of software usage? Yes
If yes, we will need you to record using screen recording software to capture the steps. If you use a Mac, QuickTime X also has the ability to record the steps.
C. Videographer: No specific critical steps were identified by the authors, however there is so little camerawork required for this publication, all the shots should be executed with care and multiple takes wherever useful should be provided.
D.  What is the single most difficult aspect of this procedure and what do you do to ensure success?  The most difficult aspect of this procedure is finding the correct, printer specific settings that enable the reliable production of the complex 3D structures of biomolecules.  (noted)
E.  Will the filming need to take place in multiple locations? No. All of the filming will be done at Brandeis University.

1. Introduction  

A. Experimental Goal (read by voice talent at JoVE):

The goal of this protocol is to create and 3D print structurally accurate biomolecular models using an affordable desktop 3D printer. 

B.  Required Interview Statements: (Said by you on camera. Don’t forget to smile!)  
1.1. Eduardo: This method is used to design 3D printable models of biomolecules from structural data, and fabricate them using low cost 3D printers.
1.2. Ian: 3D printing of physical models facilitates understanding and discussion of molecular structure and function. Interaction with the models provides an intuitive perception that greatly exceeds what is possible using a computer.
Protocol (read by voice talent at JoVE):
2. Designing 3D-printable Models
2.1. To begin the experiment, [1-WIDE] first fetch the PDB structure file of the molecule of interest by entering the PDB code in UCSF Chimera. [2.MED]
2.1.1. Talent at screen Author note: For the establishing shot of the room, we ended up showing the computer screen because we wanted to capture the “MakerLab” logo on the wall
2.1.2. Talent opens the PDB file structure in Chimera, show screen
2.2. To avoid unconnected solvent atoms in the crystal structure, select them and hide the selected “solvent” by choosing Hide under the Actions and Atoms/Bonds menu options.  [LM-TXT]
2.2.1. To be provided by authors – provide a screen capture video file that specifically includes the actions described in the narrative above.  In this video file, do not more or less than those actions.  This file should be named and uploaded according to instructions given below (see SCREEN CAPTURE box below) and then the file names should be listed in the provided media section at the end of the script.  Please follow these instructions so we can make a nice video. TEXT: Select > Structure > choose solvent
2.3. Next, thicken the diameter of the ribbon so that it can be successfully printed. Use the Ribbon Style Editor menu under Tools and Depiction. [1.LM] Under the Scaling tab, change the Height of every item to at least 0.7, according to the structure type. [2.LM-TXT]
2.3.1. To be provided by authors – provide a screen capture video file of opening the Ribbon Style Editor menu.
2.3.2. [bookmark: _o9slq3c8om23]To be provided by authors – provide a screen capture video file of adjusting the height under scaling tab. TEXT: Coil: 0.7; Helix: 1.4; Sheet:1.4; Arrow (base): 2.1; Arrow (tip): 0.7; Nucleic: 1.0.
2.4. To obtain a sturdier model, display the hydrogen bonds. [LM-TXT]
2.4.1. To be provided by authors – provide a screen capture video file of described action, TEXT: Tools > Structure Analysis > FindHBond
2.5. Then change the pseudobond style to stick and change the radius to 0.6. [LM-TXT]
2.5.1. To be provided by authors – provide a screen capture video file of described action, TEXT: Tools > General Controls > PseudoBond Panel
2.6. Now, export the displayed representation as a 3D file.  Select STL as the file type and save the model.  Further processing is still required before printing. [LM-TXT]
2.6.1. To be provided by authors – provide a screen capture video file of described action, TEXT: File > Export Scene
3. Repairing and Orienting STL Model Files 
3.1. Repair is needed due to object overlap, which is very common in complex models. [1.MED/CU] To correct this, open Autodesk Netfabb and [2.MED] import the STL file that was exported from Chimera. [3.LM]
3.1.1. Pan over some models of complex objected printed that required STL file repair Author note: “The shot was made with Meshmixer opened, showing a ubiquitin molecular model”
3.1.2. Talent at computer, opens Autodesk Netfabb
3.1.3. To be provided by authors – provide a screen capture video file of opening STL file in Netfabb
3.2. In Netfabb, open the Extras menu and select Automatic Part Repair, then select Extended Repair and wait while the file is processed. For small models, this will take seconds, but for large models it may take minutes. [LM]
3.2.1. To be provided by authors – provide a screen capture video file of described actions
3.3. Once the model has been processed, save the result. Right-click on the model and select Export Part and As STL or use Project and Export Project as STL.  The program adds “repaired” to the filename to distinguish it from the original file. [LM]
3.3.1. To be provided by authors – provide a screen capture video file of described actions, there are two options presented here, show how both are accomplished, then show the file name so the text addition of “repaired” to the filename can be seen
3.4. __author?__: The STL model can be automatically oriented using Autodesk Meshmixer, or manually oriented in Simplify3D.  Optimal orientation will lead to less support usage and reduce failure chances when printing.  
3.4.1. Interview at computer, please select a speaker
3.5. For automatic orientation, open Meshmixer and import the repaired STL file. Then, select Analysis and Orientation. Adjust the Strength Weight value to 100, adjust the Support Volume Weight value to 0, adjust the Support Area Weight to 0 and then click update.  [LM]
3.5.1. To be provided by authors – provide a screen capture video file of described actions
3.6. The model is then rotated to minimize the number of overhangs. To accept the resulting orientation, open the dropdown menu and Export the result as a binary STL file.  [LM]
3.6.1. To be provided by authors – provide a screen capture video file of described actions – showing orientation change and then saving/exporting result
4. Slicing the Model: Adding Supports and Setting the Printing Process
4.1. Open the slicing software and select the STL file [0-]. Double-click on the model and enter the scaling factor.  The default is ten million; meaning 1 cm in the printed model is equivalent to 1 nm in the molecule [1-LM]. 
Added shot: Author note: In this section, we also made a shot of the talent opening Simplify3D, which may be used as a transition scene to the screen captures (see shot “0”)
4.1.1. To be provided by authors – provide a screen capture video file of described actions, TEXT: File > Import Model 
4.2. Next, scale the ribbons and stick representations to at least 300% so that they will be large enough to print.  Surfaces can be scaled as desired.  [LM]
4.2.1. To be provided by authors – provide a screen capture video file of described actions
4.3. Adjust the orientation of the model if desired and, then, generate the support structures for the model. [LM]
4.3.1. To be provided by authors – provide a screen capture video file of rotating the model
4.4. Click the support icon and select normal supports. Specify a maximum overhang angle of 50° and pillar resolution suitable to the size of the features of your model, such as 3mm in this example.  Then click ‘generate all supports’.  These structures will hold separate and overhanging parts of the model in place during printing. [LM]
4.4.1. To be provided by authors – provide a screen capture video file of specifying pillar support details and generating supports
4.5. Next, edit the automatically generated supports to add missing supports and remove superfluous ones. First, use the Add supports tool to ensure all of the overhanging features are well supported and no structures hang in mid air. [LM]
4.5.1. To be provided by authors – provide a screen capture video file of adding supports for overhanging feature
4.6. Second, use the remove supports tool to delete supports in internal cavities, such as the inside of alpha helices or binding pockets. [LM]
4.6.1. To be provided by authors – provide a screen capture video file of removing unnecessary supports
4.7. Now, add a printing process to prepare the model G-code for a specific printer and printing material. [LM]
4.7.1. To be provided by authors – provide a screen capture video file for adding a process Merged with 4.8. 
4.8. Now, add a printing process to prepare the model G-code for a specific printer and printing material. Edit the printing process settings as follows: select the type of filament you will print with - PLA is recommended. Then, add a skirt to ensure good initial flow of the material. Then, add a raft to secure the model and supports – use an infill of 50% for ribbon models and 20% for surface models.  [LM]
4.8.1. To be provided by authors – provide a screen capture video file for editing the process settings as described Might be labeled as 4.7.1
4.9. There are numerous other parameters that can be tuned for printing success – consult the program documentation on the website for details. [LM]
4.9.1. To be provided by authors – provide a screen capture video file of opening the website that shows details
4.10. Next, click prepare to print and select the appropriate process.  This will ‘slice’ the model into layers and construct a path for the printer nozzle to follow. [LM]
4.10.1. To be provided by authors – provide a screen capture video file of the described actions.
4.11. Eduardo: Problems with the model that cause a print to fail can often be spotted in the trajectory preview. It is important to always inspect the generated trajectory, and if necessary rework your model.  [MED/WID]
4.11.1. Interview shot, at computer
4.12. Finally, inspect the G-code trajectory for errors. Look for the absence of supports under overhangs, tall isolated structures that could be knocked over, undesired cavities, or areas that are too thin to print. [LM]
4.12.1. To be provided by authors – provide a screen capture video file of scanning the G-code trajectory for possible errors in a wide variety of ways
4.13. [bookmark: _1fob9te]If the print trajectory appears satisfactory, save it as a G-code file. Otherwise edit the model, orientation, or process settings and try again. [LM]
4.13.1. To be provided by authors – provide a screen capture video file of saving the G-code
5. Printing and Post-production Processing
5.1. To begin, prepare the printer by [1.WID] loading the filament and ensuring that the bed is level. [2.MED-TXT]
5.1.1. Establishing shot of talent accessing the printer to change/load filament
5.1.2. This shot was made as a close up of the printer nozzle, showing the moment when new filament starts being extruded TEXT: Consult the printer manual for details.
5.2. Next, run the G-code on the printer, either streaming it from a computer [1.MED] or from an SD card attached to the printer.  [2.MED] Watch the print until a first layer has been successfully completed – abort the process if there are any errors. [3.LM]
5.2.1. talent opening controls on computer and sending file to printer 
5.2.2. SD card being loaded into the printer, and the print starting.
5.2.3. Printing in progress, show the first layer of the model being printed
5.3. Ian: Desktop 3D printers are prone to failure and this can be discouraging for new users. We have listed common problems and solutions in the appendix, and encourage the reader to utilize online resources to troubleshoot their printer.  
5.3.1. Interview near printer
5.4. When the print is finished, let the model cool to room temperature and then, detach it from the build plate by gently pulling it sideways. [2.CU] If the raft adheres strongly to the build plate, carefully pry it off using a sharp edge. [3.CU] [1.MED]
5.4.1. Removing model from printer and setting 
5.4.2. Removing model from print plate, sideways tug method
5.4.3. Removing model from print plate, prying with edge method
5.5. Next, remove the support structures from the model using standard pliers. [1.MED] Many can be removed with standard pliers, and those that are difficult to reach or are connected to delicate structures can be removed using cutting pliers. [2.ECU] [3.ECU]
5.5.1. Preparing to clip off structural supports, laying out tools needed next to model and getting in comfortable position to proceed
5.5.2. Using standard pliers to remove rugged supports
5.5.3. Using cutting pliers to remove delicate supports

SCREEN CAPTURES:  Authors: if we are going to show how techniques are performed on computers, you will be asked to make movie files of the software in use.  Filming screens from a video camera often results in artifacts due to the screen refresh. When you receive the final script, and a shot is listed a “SCREEN CAPTURE” you will need to make a movie file of the actions required.  Make exactly one file per requested SCREEN CAPTURE containing only the requested actions.  Do not bundle several action sequences into one large file.  Name the file according to the shot number.  Then, upload each of these files to your project folder.


6. Results: Showcase of printed models
Author note: “I think it was not clear to the editors that we would like to show the 3D printed models being manipulated, not a computer rendering. We had all the models discussed at the Brandeis MakerLab.  As such, we made shots of the models being manipulated on a white background.”
6.1. A ribbon model of ubiquitin reveals the structure of the alpha helices and beta sheets, and the location of hydrogen bonds.  By comparison, a surface model of ubiquitin could also be made. [LM] 
6.1.1. To be provided by authors – video of ubiquitin ribbon and surface models being turned side by side
6.2. By comparison, a surface model of ubiquitin could also be made. [LM]
6.2.1. To be provided by authors – video of ubiquitin surface model turning
6.3. A model of an alpha helix with atomic representation shows how amino acid residues connect with hydrogen bonds to form a helical secondary structure. [LM]
6.3.1. To be provided by authors – video of alpha helix sticks and sphere turning side by side
6.4. [bookmark: _GoBack]A histone H3 protein model can be made in ribbon and surface representations. These models reveal how multiple histones may interact with each other to form larger complexes. [1.LM]
6.4.1. To be provided by authors – video of Histone H3 ribbon and surface models side by side
6.5. An octamer of histone proteins forms the core of a nucleosome, revealing the quaternary structure of histone subunits.  The DNA that winds around the histone octamer, forming the nucleosome core particle is printed with flexible filament, enabling it to be removed, twisted and coiled.  [LM]
6.5.1. To be provided by authors – Shot was done of nucleosome model with flexible DNA. First the model was manipulated, and then the DNA was unwound from the model.
6.6. Lastly, a di-nucleosome surface model shows how nucleosome core particles form as beads on a string [1-LM]. Multiple di-nucleosomes may be stacked to reveal the helical structure of the chromatin fiber [2-LM]. 
6.6.1. To be provided by authors – Two di-nucleosomes models of about 25cm (printed at 100% scaling) being manipulated, and then stacked. 
6.6.2. Several di-nucleosomes of about 6 cm printed at 25% scaling being stacked and held in place with playdough. 
7. Conclusion (said by authors on camera)
NOTE: Authors uploaded a 3D video they wanted to use in place of the visual in the concluding statement.
7.1. Eduardo: Physical models of biomolecules have advantages over digital models.  They can be manipulated, pointed to, or passed between researchers or students.  These actions can improve the communication of ideas or information related to the biomolecule.
7.2. Ian: Because molecular models have complex 3D geometry, they can be challenging print and may require some trial and error. Our protocol will help the user overcome the some of the most common issues with the process.
7.3. Eduardo: By following this protocol, you will be able to create a digital 3D model of a biomolecule, process the 3D file, and create a physical model using a fused filament fabrication 3D printer [1-LM]. 
7.3.1. Use for visual ATPsynthase.mp4


Provided Media

Authors, Please list all images, movie files, or 3-D rendered animations that can be included in the video per editor’s request.  The step in the script/video where these images will be inserted should be specified.   For example:

6.2 –  0123_PIname_Figure1.tif -  dual color imaging of tumor angiogenesis at 40X 
6.2 –  0123_PIname_Figure2.tif -  dual color imaging of tumor angiogenesis at 100X

Formats:  For static images we prefer .tiff, .eps, Illustrator, Powerpoint or Photoshop files at dimensions of at least 720X480 pixels and 300 dpi.  The higher resolution, the better.  Likewise any exported movie files should have at minimum these dimensions and be rendered to .mov, .mp4, or .avi files.  


General Preparation

It’s critical for a smooth and organized shoot that all reagents are accounted for, in advance.   

Any overnight or long incubation steps should be recognized and specimens/samples be prepared in advance so that prior steps can be recorded and shooting can continue with pre-prepared specimens/samples.  

All tubes/flasks should be pre-labeled neatly before we arrive.  

Ex. Luciferase assay done in 96 well plates should be labeled with negative/positive control wells and experimental samples are labeled accordingly.

You will receive more detailed preparation instructions are included in the email accompanying the finalized script.
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